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1. Introdução 

Pretende-se com este trabalho de laboratório analisar o funcionamento do circuito inversor CMOS 

apresentado na Figura 1, que é constituído por dois transístores complementares MOS (NMOS - 

canal N e PMOS - canal P). Serão consideradas diversas características deste circuito inversor, 

nomeadamente, a sua característica de transferência, as margens de ruído e os tempos de atraso 

de propagação. 

A montagem do circuito inversor baseia-se na utilização do circuito integrado CD4007 [1], que 

contém seis transístores MOS de reforço, sendo três de canal N e os restantes de canal P. 

O trabalho de laboratório é realizado em duas sessões: 

• Antes da primeira sessão deve ser realizada a análise teórica do circuito, conforme a 

secção 3 deste guia e uma preparação prévia para a simulação elétrica do circuito, 

particularmente na utilização do simulador utilizado LTspice [2] [3]. 

• Na primeira sessão devem ser realizadas as simulações elétricas do circuito, conforme 

seção 4 deste guia e ser apresentados ao docente os resultados da análise teórica e da 

simulação. Caso disponham de tempo livre, podem aproveitar esta sessão para a 

montagem do circuito e a realização de algumas medidas experimentais. 

• A segunda sessão de laboratório serve para realizar as medições experimentais e terminar 

o relatório. 

                

VDD 

VSS = 0 V

M1

M2

vI vO 

ID

    
Figura 1 – (a) Circuito inversor CMOS e (b) esquema interno do circuito integrado. 

VDD 

VSS 

(GND) (a) (b) 
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2. Material de Laboratório e Equipamento 

Para a realização do trabalho experimental é necessário o seguinte material e equipamento: 

• Circuito integrado CD4007 

• Base de montagem com fonte de alimentação DC e placa de breadboard 

• Multímetro, osciloscópio e gerador de sinais 

3. Análise Teórica 

Considere o circuito inversor CMOS da Figura 1 em que os transístores são caracterizados pelos 

parâmetros indicados na Tabela 1, o valor de VDD é indicado na Tabela 5 e o valor de VSS é 0 V.  

Tabela 1 – Características dos transístores MOS 

 
W L  kp 

L

W
kk p

2

1
=  Vt 

NMOS (M1) 40 m 5 m 0 73 A/V
2
 292 A/V

2
 1.9 V 

PMOS (M2) 150 m 5 m 0 16 A/V
2
 240 A/V

2
 -1.7 V 

3.1. Calcule a tensão de saída vO e a corrente iD nos transístores M1 e M2 para vi = 0V, vi = 

VDD/2, e vi =VDD. Indique nas três situações qual a região de funcionamento dos 

transístores. 

3.2. Determine e represente graficamente a característica de transferência vo(vi) do circuito. 

Assinale as diferentes zonas de funcionamento de cada um dos transístores, bem como 

as tensões vi e vo nos pontos de transição entre as diferentes zonas de funcionamento. 

3.3. Determine o valor máximo da corrente ID. 

3.4. Determine as tensões VOL, VOH, VIL, VIH e calcule as margens de ruído NML e NMH. 

3.5. Considere ligada na saída uma carga capacitiva CL = Cp = 180 pF à massa, que simula a 

capacidade parasita associada à entrada do osciloscópio e ao respetivo cabo presentes 

nas medidas experimentais em laboratório. Determine os tempos de atraso de 

propagação (tPHL, tPLH e tP). Determine também os tempos de atraso de propagação 

quando adiciona ainda uma capacidade C1 (indicada na Tabela 5), ficando CL = Cp + C1.  

NOTA: 

• Nas equações da corrente dos transístores deve considerar para o transístor PMOS Vt>0, ou 

seja Vt=1,7V, uma vez que devido à forma como são definidas as equações: 

 nMOS enriquecimento pMOS enriquecimento 

Equações das aulas teóricas Vt>0  (1.9V) Vt>0  (1.7V) 

Equações do LTspice Vt>0  (1.9V) Vt<0  (-1.7V) 

 



4 

 

 

LAB1 
Inversor CMOS 

Eletrónica I 
2º Semestre 2019/2020 

 

4. Simulação 

Para realizar a simulação do funcionamento do inversor CMOS utilize os valores de W e L indicados 

na Tabela 1 e os parâmetros indicados na Tabela 2. No Anexo A é descrita sucintamente a forma de 

editar um diagrama esquemático no programa LTspice e de introduzir os valores das dimensões dos 

parâmetros dos transístores.  

Tabela 2 – Parâmetros dos transístores a utilizar no LTspice 

NMOS .MODEL N4007 NMOS W=40u L=5u TOX=70n KP=73u VTO=1.9V GAMMA=2.0 CBD=0.2p CBS=0.2p MJ=0.75 LAMBDA=20m 

PMOS .MODEL P4007 PMOS W=150u L=5u TOX=70n KP=16u VTO=-1.7V GAMMA=1.0 CBD=0.2p CBS=0.2p MJ=0.75 LAMBDA=20m 

 

Considere inicialmente no modelo dos transístores  = 0 (LAMBDA=0) para comparar os resultados 

da simulação com os da análise teórica:  

4.1. Determine a tensão de saída e a corrente nos transístores, para vi = 0V, vi = VDD/2 e 

vi = VDD. Para isso faça uma análise do ponto de funcionamento em repouso (“DC op 

pnt”). 

4.2. Obtenha também o gráfico de iD(vi), fazendo uma análise com varrimento do sinal de 

entrada (“DC Sweep”) de vi = 0 V a vi = VDD. Determine o valor máximo da corrente iD. 

4.3. Obtenha também a característica de transferência vo(vi). A partir desta característica, 

determine as tensões VOL, VOH, VIL, VIH e calcule as margens de ruído NML e NMH.  

Nota: Para  = 0 a transição da característica de transferência de vo(vi) tem um declive 

extremamente elevado, pelo que deve ser escolhido um número de pontos de varrimento 

adequado para a representação dessa característica de forma o mais precisa possível. 

Sugestão: obtenha dvo/dvi através da função d() do LTspice (ver anexo A). 

4.4. Aplique na entrada um sinal retangular (utilize um gerador de impulsos PULSE) com 

níveis de tensão 0V e VDD, frequência 200kHz, e tempo de subida e tempo de descida 

desprezáveis face a tP (por exemplo 1ns). Acrescente na saída uma carga capacitiva CL. 

Obtenha um gráfico das tensões de entrada e de saída fazendo uma análise no domínio 

do tempo (“Transient”) nas seguintes situações: 

• C1 = 0, CL = Cp = 180 pF; 

• CL = Cp + C1 em que o valor de C1 é o indicado na Tabela 5. 

A partir dos gráficos obtidos determine os tempos de atraso de propagação (tpLH, tpHL e tp). 

Sugestão: Faça “zoom” nas zonas de transição dos sinais e utilize o cursor para obter resultados 
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mais exatos. 

4.5. Compare os valores obtidos na simulação com os valores obtidos na análise teórica e 

comente as diferenças encontradas nos valores máximos da corrente iD, das tensões e 

correntes em repouso; das tensões VOL, VOH, VIL, VIH; das margens de ruído NML e NMH; 

e dos tempos de atraso de propagação (tpLH, tpHL e tp). 

Considere agora o modelo dos transístores com  = 20 mV-1:  

4.6. Obtenha o gráfico de iD(vi). 

4.7. Obtenha a característica de transferência vo(vi). A partir desta característica, determine 

as tensões VOL, VOH, VIL, VIH e calcule as margens de ruído NML e NMH. 

4.8. Compare os valores obtidos na simulação com  =0 e  = 20 mV-1 e comente as 

diferenças nos valores obtidos para a corrente iD máxima, para as tensões VOL, VOH, VIL, 

VIH, e para as margens de ruído NML e NMH. 

 

5. Trabalho Experimental 

 

5.1. Consulte a folha de catálogo com as características do circuito integrado CA4007. 

Identifique os pinos do circuito integrado correspondentes aos terminais da Figura 1 (b). 

Monte o circuito inversor na placa de breadboard. Não ligue a fonte de alimentação. 

5.2. Ajuste a fonte de tensão para obter a tensão VDD. Depois de ter verificado que o nível de 

tensão está correto ligue VDD e VSS (GND) ao circuito integrado montado na breadboard. 

5.3. Verifique o funcionamento do circuito efetuando os seguintes testes e registando os 

PRECAUÇÕES: 

• Nunca aplique sinais na entrada do circuito sem 

ter a certeza de que o circuito integrado já está 

devidamente alimentado através dos pinos 7 

(GND) e 14 (VDD), que são ligações obrigatórias. 

• Deverá utilizar um dos 3 conjuntos do CD4007: 

 Esquerda Centro Direita 

Entrada (vi) 6 3 10 

Saída (vo) 8-13 1-5 12 

VDD 14 2-14 11-14 

GND 7 4-7 7-9 

 

VDD 

VSS 

(GND) 

Esquerda Centro Direita 

Figura 1 (b) 

http://www.ti.com/lit/gpn/cd4007ub
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valores obtidos: 

I. Aplique na entrada um sinal vI = 0 V e meça com o voltímetro a tensão de saída vO. 

II. Aplique na entrada um sinal vI = VDD e meça com o voltímetro a tensão de saída vO.   

III. Aplique na entrada um sinal vI = VDD/2 e meça com o voltímetro a tensão de saída vO.  

Nota: Para obter VDD/2 deve realizar um divisor resistivo ligado a VDD com 2 resistências 

iguais.  

5.4. Ligue o gerador de sinais ao canal 1 do osciloscópio e ajuste-o para obter um sinal 

sinusoidal de 1 kHz sobreposto a uma componente contínua: v(t) = VDD/2 + VDD/2 cos(t).   

Certifique-se que o circuito está alimentado e só então aplique este sinal sinusoidal, que 

varia de 0V a VDD, na entrada do inversor CMOS. Observe no osciloscópio os sinais de 

entrada (canal 1) e de saída (canal 2) no domínio do tempo. Utilize os canais do 

osciloscópio sempre em acoplamento CC (ver Anexo B). 

Obtenha a característica de transferência vO(vI), através de um gráfico realizado no 

programa Excel ou colocando o osciloscópio em modo xy. Imprima o gráfico (ver Anexo 

B).  

Nota: Para melhorar a resolução da característica de transferência, pode utilizar o 

osciloscópio em modo de aquisição de alta resolução ou modo de aquisição de médias (ver 

Anexo B).  

Utilize a funcionalidade do osciloscópio que lhe permitem guardar as formas de onda 

visualizadas (guardar os pontos através do Excel no PC ou de uma PEN). 

5.5. Mantendo as condições da alínea anterior, utilize o gráfico obtido para determinar as 

tensões VOL, VOH, VIL, VIH e calcular as margens de ruído NML e NMH. Poderá obter os 

valores de VIL e VIH encontrando os pontos de declive -1. 

5.6. Utilize o gerador de sinais para obter uma onda quadrada de frequência 200kHz e 

valores extremos de 0V e VDD. Certifique-se que o circuito está alimentado e só então 

aplique a onda quadrada na entrada do inversor CMOS. Observe no osciloscópio os 

sinais de entrada e de saída. Coloque a escala de tempo do osciloscópio no seu valor 

mínimo para melhor visualização das transições das formas de onda. Obtenha um 

gráfico contendo as transições L → H e H → L (ver Anexo B) nas seguintes situações: 

I. Sem qualquer capacidade na saída do circuito. 

II. Com uma capacidade colocada na saída (C1 conforme Tabela 5). 
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6. Relatório 

O relatório é entregue até 24 horas após a final da aula em que se realiza a segunda sessão de 

laboratório (por exemplo se a aula terminar às 17:00 horas o relatório terá que ser entregue até às 

17:00 horas do dia seguinte).  

A entrega do relatório é feita através de upload no sistema Fénix (Avaliação → Projetos) de um ficheiro 

pdf obrigatoriamente com o nome LAB1-gr-n1-n2-n3.pdf, sendo gr o nº do grupo (01, 02, 03, etc.) e n1, 

n2, n3 os números dos alunos.  

 

Estrutura 

O relatório deve obrigatoriamente respeitar a seguinte estrutura sequencial de secções: 

• Análise teórica que inclui as respostas às questões 3.1 a 3.5.  

Notas:  

o Não devem ser apresentadas deduções, mas apenas as fórmulas usadas e a 

respetiva referência ao texto de onde foram obtidas (por exemplo, o livro ou as 

transparências das aulas teóricas). Caso pretendam incluir deduções, devem colocá-

las em anexo. 

o Todas as aproximações feitas nos cálculos devem ser justificadas. 

• Simulação que inclui as respostas às questões 4.1 a 4.8. Sempre que se justifique 

assinale os valores pedidos sobre os próprios gráficos. 

• Trabalho experimental que inclui as respostas e gráficos referentes às questões 5.3 a 5.6. 

• Análise dos resultados que compara os valores obtidos e comenta as diferenças 

encontradas, devendo incluir as tabelas de comparação de resultados devidamente 

preenchidas, cujos modelos (Tabela 3 e Tabela 4) são dados através de um ficheiro Excel 

que deve ser editado e alterado da forma que se considere mais conveniente: 

• Análise comparativa de resultados teóricos, de simulação e experimentais, conforme 

Tabela 3 (valores máximos da corrente iD; tensões e correntes em repouso; tensões 

VOL, VOH, VIL, VIH; margens de ruído NML e NMH; tempos de atraso de propagação 

tPHL, tPLH e tP) e das características de transferência. 

• Análise comparativa de resultados de simulação para =0 e ≠0 relativos à Tabela 4 

(valor máximo da corrente iD; tensões VOL, VOH, VIL e VIH; margens de ruído NML e 

NMH) e características de transferência. 
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Tabela 3 - Comparação resultados teóricos, simulação e experimentais 

 
 

 
Tabela 4 - Comparação das simulações com  = 0 e  ≠ 0. 

 
 

 

Apresentação 

O relatório deve ter em conta os seguintes princípios: 

• Possui apenas figuras e tabelas (não há gráficos, quadros, etc.) que devem ser centradas 

horizontalmente na página. Todas as figuras e tabelas devem ser legendadas, referenciadas 

no texto, ter um tamanho de caracter adequado para fácil leitura e não ultrapassar as 

margens do relatório. A legenda das figuras deve vir depois destas e a das tabelas antes. 

Comparação resultados teóricos, simulação e experimentais

VDD = 

Secção Valores Secção Valores
Comparação c/ 

teóricos
Secção Valores

Comparação c/ 

teóricos

vo(0) (V) #DIV/0! #DIV/0!

iD(0) (mA) #DIV/0!

vo(VDD/2) (V) #DIV/0! #DIV/0!

iD(VDD/2) (mA) #DIV/0!

vo(VDD) (V) #DIV/0! #DIV/0!

iD(VDD) (mA) #DIV/0!

Corrente iD máxima iDmax (mA) 3.3 4.2 #DIV/0!

VOL (V) #DIV/0! #DIV/0!
VOH (V) #DIV/0! #DIV/0!

VIL (V) #DIV/0! #DIV/0!

VIH (V) #DIV/0! #DIV/0!

NML (V) #DIV/0! #DIV/0!

NMH (V) #DIV/0! #DIV/0!

tpLH (ns) #DIV/0! #DIV/0!

tpHL (ns) #DIV/0! #DIV/0!

tp (ns) #DIV/0! #DIV/0!

tpLH (ns) #DIV/0! #DIV/0!

tpHL (ns) #DIV/0! #DIV/0!

tp (ns) #DIV/0! #DIV/0!

NOTAS:

    1. Preencher os  va lores  das  células  a  azul

    2. Preencher os  va lores  dos  campos  ass ina lados  entre "<" e ">" (va lores  de V DD e C1)

    3. Colocar o número de casas  decimais  da  forma que for mais  conveniente

Tempos de propagação (C1=0)

Tempos de propagação 

(C1=<colocar valor> pF)

Teóricos

Tensões limite e margens de 

ruído

Tensões e correntes em repouso 3.1

3.4

3.5

<colocarVDD>

4.3

4.1

5.64.4

ExperimentaisSimulação

5.3

5.5

 Comparação das simulações com =0 e ≠0

VDD = 

Secção Valores Secção Valores
Comparação c/ 

=0

Corrente iD máxima iDmax (mA) 4.3 4.6 #DIV/0!

VOL (V) #DIV/0!

VOH (V) #DIV/0!

VIL (V) #DIV/0!

VIH (V) #DIV/0!

NML (V) #DIV/0!

NMH (V) #DIV/0!

NOTAS:

    1. Preencher os valores das células a azul

    2. Preencher os valores dos campos assinalados entre "<" e ">" (valor de V DD)

    3. Colocar o número de casas decimais da forma que for mais conveniente

Simulação om =0 Simulação om ≠0

Tensões limite e margens de ruído 4.4 4.7

<colocarVDD>
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• As figuras contendo gráficos devem possuir legendas nos dois eixos, com a entidade 

representada e respetivas unidades, como por exemplo Vin (V).  

• As curvas apresentadas em gráficos devem ser identificadas, as escalas devem ser 

incluídas e, se for o caso, os pontos notáveis das curvas devem estar claramente 

identificados.  

• As equações não devem ser inseridas no texto, mas sim escritas em linha própria, alinhadas 

ao centro e numeradas à direita sequencialmente como se exemplifica de seguida: 

 𝑖𝐷 = 𝑘(𝑣𝐺𝑆 − 𝑉𝑡)
2                  (1) 

• As equações devem ser referidas no texto apenas pelo seu número, como por exemplo (1). 

• Todos os valores apresentados no relatório devem incluir as unidades e devem usar um 

número de dígitos significativos apropriado à grandeza em causa. 

 

Classificação  

O relatório deve ter uma estrutura e apresentação cuidada, que corresponderá a 20% na 

avaliação do trabalho. A análise teórica corresponde a 10%, a simulação 10%, a apresentação 

dos resultados experimentais 10%, a análise de resultados 40% e as conclusões 10%. 

 

7. Valores relacionados com o número do grupo 

Os valores de VDD e C1 dependem do número do grupo de acordo com a Tabela 5. 

Tabela 5 - Valores de VDD e C1 

Grupo nº VDD (V) 

1 2 3 4 6 

5 6 7 8 7 

9 10 11 12 8 

13 14 15 16 9 

17 18 19 20 10 

21 22 23 24 6 

25 26 27 28 7 

29 30 31 32 8 

33 34 35 36 9 

37 38 39 40 10 

41 42 43 44 6 

45 46 47 48 7 

49 50 51 52 8 

53 54 55 56 9 

57 58 59 60 10 

390 470 560 680 C1 (pF) 
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Anexo A. Simulador LTSPICE 

Para utilizar o simulador LTspice pode seguir os tutoriais indicados [3]. Segue-se uma pequena 

introdução ao simulador utilizando como exemplo o circuito da Figura 1. 

 

Criação do diagrama esquemático  

No LTspice crie um novo esquema (File → New Schematic). Coloque no esquema os componentes 

da Figura 1: um transístor pmos, um transístor nmos e duas fontes de tensão (voltage). Coloque 

também o nó de referência GND. Na Figura 2 mostra-se o menu de componentes para edição do 

esquema, que contém um conjunto de componentes típicos e os comandos principais de edição. A 

figura representa também uma tabela com as principais teclas rápidas do programa. 

                                       

Figura 2 – Menu de componentes do LTspice para edição do esquema e teclas rápidas. 

Na Figura 3 apresentam-se os botões para edição do esquema (presentes na parte superior da 

janela do programa) com os comandos principais de edição. 

 

Figura 3 – Botões para edição do esquema. 

Teclas rápidas: 

F1 Ajuda (Help) 

F2 Componente (Component) 

F3 Ligação (Draw Wire) 

F4 Nome a nó (Label net) 

F5 Apagar (Delete) 

F6 Duplicar (Duplicate) 

F7 Mover (Move) 

F8 Arrastar (Drag) 

F9 Retroceder (Undo) 
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Para colocar um componente selecione Edit → Component (tecla F2 ou símbolo ) e escolha um 

dos componentes disponíveis na lista. Pode também usar os botões da interface. A Figura 4 

apresenta parte dessa lista podendo também usar os botões referidos acima. A Figura 4 apresenta 

essa lista onde estão assinalados os três componentes necessários para o esquema da Figura 1: 

fonte de tensão (“voltage”), transístor nmos (“nmos”) e transístor pmos (“pmos”). 

A posição de um componente pode ser modificada com o comado Edit → Move (ou tecla F7 ou 

símbolo ), selecionando o componente a ser deslocado. Através de CNTRL R e CNTRL E o 

componente pode ser rodado ou espelhado. 

Depois de colocados os componentes e o nó de referência (Ground ou símbolo ), que é  

obrigatório, complete as ligações com Edit → Draw wire (tecla F3 ou símbolo ). Edite o valor da 

fonte de tensão ligada ao transístor pmos para atribuir o valor de VDD, premindo a tecla direita do 

rato sobre o valor atribuído por defeito “V”. 

 

Figura 4 – Componentes da biblioteca do LTspice. 

 

Modelo dos transístores MOS 

Crie, a partir dos transístores pmos e nmos, modelos para os dois transístores P4007 e N4007. 

Premindo a tecla CTRL e o botão direito do rato sobre o transístor altere o campo Value de 

NMOS para N4007 e de PMOS para P4007, para os transístores nmos e pmos, 

respetivamente. Na Figura 5 ilustra-se a criação de um modelo para o transístor P4007. 
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Figura 5 – Identificação de um novo modelo para o transístor pmos. 

Associe os modelos da Tabela 2 e as dimensões da Tabela 1 aos símbolos criados para os modelos 

dos transístores N7007 e P4007, criando uma diretiva para o SPICE com o comado Edit → Spice 

Directive. A Figura 6 mostra a introdução das dimensões (W=150u, L=5u) e dos parâmetros do 

modelo (TOX=70N KP=16u VTO=-1.7V GAMMA=1.0 CBD=0.2p CBS=0.2p MJ=0.75 LAMBDA=20m) 

e para o transístor P4007 e a Figura 8 o esquema final com modelos assumindo VDD=6V. 

 

Figura 6 – Associação de um modelo ao símbolo P4007.  

A Figura 7 ilustra o resultado final do esquema do inversor CMOS com os modelos dos transístores. 

 

Figura 7 – Esquema final com modelos (com VDD=8V e vi=VDD/2). 
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Para facilitar a introdução da informação nos modelos dos dois transístores poderá fazer copy e 

paste das seguintes linhas: 

NMOS .MODEL N4007 NMOS W=40u L=5u TOX=70n KP=73u VTO=1.9V GAMMA=2.0 CBD=0.2p CBS=0.2p MJ=0.75 LAMBDA=20m 

PMOS .MODEL P4007 PMOS W=150u L=5u TOX=70n KP=16u VTO=-1.7V GAMMA=1.0 CBD=0.2p CBS=0.2p MJ=0.75 LAMBDA=20m 

 

Simulação 

Para simular o circuito, defina o tipo de análise a efetuar, utilizando o comando Edit → Spice 

analysis. Na Figura 8 aparecem os tipos de análise possíveis, devendo dar o OK na janela e colocar 

sobre o esquema o termo correspondente à análise: 

• Para calcular os valores no ponto de funcionamento em repouso (tensões e correntes DC), 

selecione “DC op pnt” (Figura 8). 

• Para obter gráficos de tensões ou correntes DC para diferentes valores de uma fonte 

selecione “DC Sweep”, preenchendo os valores tal como se representa na Figura 9, 

correspondente a variar vi de forma linear entre 0 e 10V com um passo de 0.01V (ou seja 

1000 pontos). 

• Para obter gráficos das tensões de entrada e de saída no domínio do tempo selecione 

“Transient”, preenchendo os valores tal com se representa na Figura 10, correspondente a 

uma análise desde t=0 a t=10s e com um passo máximo de 0.1ns. 

 

 
 

Figura 8 – Definição do tipo de simulação – “DC op pnt”. 
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Figura 9 – Definição do tipo de simulação – “DC sweep”. 

 
 

Figura 10 – Definição do tipo de simulação – “Transient”. 

 

Para qualquer das simulações tem que se indicar qual o tipo de sinal da fonte de tensão (VI no caso 

da Figura 7) do circuito: 

• Para a análise DC  VDD/2 DC (ou outro valor) 

• Para a análise DC sweep Variando de 0 a VCC 

• Para a análise transitória Onda quadrada (“PULSE”) variando de 0 a VDD 

A ordem de simulação é dada através do menu Simulate → Run (ou símbolo ). 

Na Figura 11 apresenta-se o resultado da simulação do ponto de funcionamento em repouso para 

VDD=8V e vi=VDD/2. Os resultados das tensões dos nós e das correntes nos ramos podem ser 

visualizados sobre o circuito (premindo a tecla direito do rato sobre o nó que se pretende medir e 

selecionando “Place .op data label” – ) ou na janela de texto que aparece após a simulação. 
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Figura 11 – Simulação do ponto de funcionamento em repouso para VI =4 V. 

A Figura 12 mostra a configuração de uma fonte de tensão (voltage) como gerador de impulsos 

(“PULSE”). Para obter a janela de configuração, pressione o botão direito do rato sobre a fonte (VI 

na Figura 11). 

 

Figura 12 – Gerador de impulsos. 

Os parâmetros a preencher para “PULSE” são apresentados na figura Figura 13, sendo que na 

Figura 12 foi considerada uma fonte com valor mínimo 0V, máximo 8V, sem atraso, com tempos se 

subida e descida muito baixos (1ns), largura de impulso (Ton=2.5s) e período (Tperiod=5s), 

correspondente a uma onda quadrada de 200kHz com duty-cycle de 50%. 
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Figura 13 – Parâmetros de uma forma de onda PULSE. 

 

Visualização de formas de onda 

Após ser dada a ordem de simulação o utilizador deverá indicar os sinais que pretende obter 

graficamente. Para tal ou clica sobre os respetivos nós do circuito ou executa os comandos Plot 

Settings → Visible Traces e Plot Settings → Add Traces que permitem especificar as formas de 

onda a visualizar. Permitem também especificar operações matemáticas que podem ser realizadas 

sobre os resultados de simulação. A derivada d(x) é um dos exemplos de operação que pode ser 

efetuada. 

A Figura 14 representa um exemplo de simulação do circuito da Figura 1 no domínio do tempo 

(“Transient”), considerando uma onda quadrada em V1 (“PULSE”). 

 

Figura 14 – Simulação do circuito da Figura 1 no domínio do tempo com uma onda quadrada em VI. 

t 0 

Vinitial 

Von 

Trise Tfall Tdelay Ton 

Tperiod 
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Anexo B. Osciloscópio 

Este anexo contém apenas a descrição dos comandos dos osciloscópios referidos na Secção 5, em 

particular alguns dos que permitem obter as medidas experimentais. Para utilizar o osciloscópio 

recomenda-se a consulta dos manuais [4] ou [5], para o osciloscópio configurado em língua 

portuguesa ou inglesa, respetivamente. 

A Figura 15 mostra o painel frontal dos osciloscópios InfiniiVision 2000 X-Series da Keysight 

Technologies (anteriormente Agilent) com indicação da funcionalidade das várias teclas.  

 

Figura 15 – Painel frontal dos osciloscópios InfiniVision 2000 X-Series (extraído de [4]). 

 

Acoplamento AC e CC  

Primeiro selecione o botão do canal botão (1, 2, 3 ou 4) para o qual pretende definir o tipo de 

acoplamento. Em seguida escolha o tipo de acoplamento no menu de canal, rodando o botão 

ENTRY (Controle Entry na Figura 15) ou usando a softkey por baixo do respetivo menu. No exemplo 

da Figura 16 foi selecionado o canal 2, vendo-se no respetivo menu de canal (Menu 2Canal) que o 

acoplamento é do tipo CC. 
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Figura 16 – Acoplamento AC e CC 

 

Modo XY  

Pressione a tecla [Horiz] do painel frontal. Selecione o modo "XY" no Menu Horizontal girando o 

botão ENTRY ou usando a softkey por baixo do menu (Menu Horizontal) como se mostra na Figura 

17.  

                  

Figura 17 – Menu horizontal. 

Centre o sinal no ecrã com os botões de controlo de posição dos canais 1 e 2 (  ). Use os botões 

de controlo das escalas (volts/div) dos canais 1 e 2 e as softkeys Fine (pressione a tecla [Horiz]) para 

expandir o sinal e tornar a sua visualização adequada. 

 

Medições de tempos de propagação 

Para fazer medições automáticas pressione a tecla [Meas] do painel frontal. Rode o botão ENTRY 

ou use a softkey Fonte por baixo do menu Medição, para selecionar o canal de uma das formas de 
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onda. Pressione a softkey Tipo, e gire o botão Entry ou pressione a softkey para selecionar o tipo 

de medição. A Figura 18 mostra o menu com alguns dos tipos de medição que podem ser efetuados 

(frequência e amplitude pico-a-pico do canal 1). 

 

Figura 18 – Medições automáticas  

Para medir o atraso entre duas ondas selecione o tipo de medição Retardo (Delay). O atraso 

medido é a diferença de tempo entre os pontos médios da transição selecionada para a fonte 1 e a 

transição selecionada para a fonte 2, mais próximas do ponto de referência do disparo (trigger). Na 

configuração padrão são consideradas as transições ascendentes das duas formas de onda como 

se vê na Figura 19. Valores de atraso negativo indicam que a transição selecionada para a fonte 1 

ocorreu após a transição selecionada da fonte 2. 

 

Figura 19 – Medição do atraso (retardo). 

 

Para definir o atraso entre tipos diferentes de transição, depois de selecionar a fonte, pressione a 

softkey Definições para configurar o tipo de transição (L→H ou H→L) para cada uma das fontes 

(canais). Na Figura 20 configurou-se as seguintes medições: 

• tpHL: Retardo (delay), com o Canal 1 na transição L→H e o Canal 2 na transição H→L 

• tpLH: Retardo (delay), com o Canal 1 na transição H→L e o Canal 2 na transição L→H 

• tr: Tempo de subida para o Canal 2 

• tf: Tempo de descida para o Canal 2 

Depois de configurar as transições, pressione a tecla BACK ( ) para retornar ao menu Medição. 

Pressione a softkey Adicionar Medição para acrescentar a medida no ecrã do osciloscópio. 
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Figura 20 – Medição dos tempos de propagação e de subida/descida. 

 

Modo de Aquisição 

Os modos de aquisição de Alta Resolução e de Média reduzem o ruído aleatório e melhoram a 

resolução vertical. Para usar estes modos, pressione a tecla [Acquire] do painel frontal e gire o 

botão Entry ou pressione a softkey para selecionar o modo Alta Resolução ou de Médias no Menu 

aquisição. Se o sinal for repetitivo e muito estável o modo de médias resulta muito bem, 

particularmente melhor que o da alta resolução, em especial para um número de médias elevado de 

128 ou superior, devendo ter-se em atenção que para um número de medias muito elevado os 

osciloscópio demora mais tempo a estabilizar as medições. 

 

Guardar imagens e formas de onda visualizadas 

Para guardar as formas de onda visualizadas ou os dados das medições, utilize o osciloscópio em 

modo de aquisição de médias (Média), porque reduz o ruído, ficando o gráfico com melhor definição. 

As formas de onda visualizadas podem ser armazenados num dispositivo de armazenamento USB 

ou obtidas no PC da bancada que está ligado ao osciloscópio. 

Para transferir a informação de um dispositivo de armazenamento USB, após colocar a PEN USB no 

osciloscópio prima a tecla [Save/Recall], de seguida deve selecionar o tipo de ficheiro através da 

softkey Formato (PNG ou BMP para imagem e CSV para dados, que podem depois ser trabalhados 

no Excel) e finalmente premir a softkey Salvar para guardar a informação na PEN. 

tpHL 

tpLH 

tr 

tf 
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Para obter as formas de onda no PC: 

• Abra o programa Excel e selecione o menu Add-Ins (Figura 21), ficando com acesso às 

opções indicadas na Figura 22.  

• Se selecionar a opção (Get Waveform Data), obtém os valores das formas de onda em 

colunas do ficheiro em função do tempo e a respetiva representação gráfica como se vê 

Figura 22 (a). 

• Se selecionar a opção  (Get Screen Image), obtém a imagem do osciloscópio como se vê 

Figura 22 (b). Nesta opção, pode ainda escolher armazenar o ficheiro com a imagem num 

diretório do PC.  

 

Figura 21 – Opções de aquisição das formas de onda visíveis no osciloscópio.  

 

     
(a) Dados                                                                (b) Imagem 

Figura 22 – Formas de onda visíveis no osciloscópio.  

 

 

Exemplos de imagens obtidas 

A Figura 23 mostra dois exemplos de imagens obtidas nos pontos 5.5 (com o osciloscópio em modo 

xy) e 5.6 (Fonte onda quadrada) deste guia. 
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Figura 23 – Exemplos de imagens obtidas com o osciloscópio. 
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